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Please do not write down any passwords here or anywhere else
on the printed materials.

If you need assistance logging into any of the computers or
software at the site, please ask your Site Manager/Leader.

If you would like to save this information somewhere, please
save it in your smartphone.
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LADDER UP OVERVIEW

Mission

Ladder Up is committed to helping hardworking families and individuals access the
financial resources and tools they need to move up the economic ladder. Whether it is
helping clients obtain the tax refunds they deserve, secure the financial aid that makes
higher education affordable, or gain the knowledge to make sound financial decisions,
Ladder Up provides free financial services to help Chicago-area families and individuals
improve their quality of life.

Ladder Up’s volunteer corps is one of the largest volunteer workforces in the Midwest.
Partnering companies represent various sectors, including accounting, banking,
consulting, law, and financial services. By utilizing the donated service of its volunteers,
along with donated office space, legal counsel, and service locations, Ladder Up is able
to return $27 in benefits to clients for every $1 invested in the organization.

LADDER UP PROGRAMS:
TAX ASSISTANCE PROGRAM (TAP)

Ladder Up offers free tax preparation and electronic filing to help low- to moderate-
income taxpayers secure valuable tax refunds. By engaging over 1,000 volunteers each
year, Ladder Up provides free tax help to clients at over 20 service locations, mostly in
the Chicagoland area.
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FINANCIAL CAPABILITY

Higher Education Access Initiative

Ladder Up helps students secure financial aid through assistance with the Free
Application for Federal Student Aid (FAFSA). During FY 2018-2019, Ladder Up assisted
5,967 students and parents with the FAFSA and financial aid presentations and
workshops, helping them secure an estimated $18.85 million in financial aid awards for
higher education. Ladder Up also educated students about award letters, college
finances, student loans, and personal statements by offering workshops to students.

Financial Literacy Program

Ladder Up helps high school students and adults lay the foundation for financial stability
by offering one-on-one financial coaching and leading workshops on topics including
credit, banking, and consumer choices. During FY 2018-2019, Ladder Up reached over
2,343 individuals through workshops and one-on-one financial coaching. The
organization also helped clients access 1,707 asset building services at tax sites through
its Save Up pilot program.

Asset Building at Tax Time

Ladder Up leverages tax time to connect low-income clients with asset-building services
including credit report pulls, financial coaching, fee-less debit cards, and incentivized
savings opportunities.

If a client is interested in financial aid services or financial coaching, please ask
them to call and leave a message at (312) 409-1555 or e-mail
SaveUp@goladderup.org.
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FREE TAX CLINIC

The Tax Clinic provides legal counsel and representation to clients in tax disputes with
the IRS and lllinois Department of Revenue (IDOR). The clinic assists clients with the
following types of matters:

- Audits

- Collections

- Problems related to the ACA

- Family Status Issues (F/S, DX, EIC CTC)

- EITC and Child Tax Credit disputes

- Cancellation of Indebtedness (1099-C, 1099-A, Underreported CP2000 Letter)
- Unreported Income

- Misclassified Worker Disputes (Form SS-8, Form 4852)
- Injured Spouse

- Innocent Spouse Relief

- Other issues arising from dispute with IRS or IDOR

Cases that are Out-of-Scope for the Tax Clinic:

- Property Tax

- Taxes collected by IL Dept of Employment Security

- Disputes between/among taxpayers

- Employment matters

- Non-tax debt collection and refund offsets

- Business entities (however, the tax clinic can assist sole proprietorships and sole
shareholders in an S-Corporation or LLC)

- Disputes with paid prepares over rapid refunds

Any lllinois taxpayer who meets our tax preparation income guidelines is eligible for free

services from the Tax Clinic.

If a client needs to contact the Tax Clinic, please ask them to call (312) 630-0242,
or e-mail info@goladderup.org
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VOLUNTEER TRAINING, ROLES, AND
CERTIFICATION

Ladder Up requires that all volunteers complete five online training modules that cover
site process and policies, as well as tax law that pertains to VITA programs.

Per IRS rules, all Ladder Up volunteers must pass the IRS prerequisites (Volunteer
Standards of Conduct and Intake/Interview & Quality Review Tests) with 80% or higher
every year before attending a volunteer session. Additional training varies by role.

Role Responsibilities

Site Leader Manages site operations, clients, and volunteers. Site Leaders need to attend
an additional half-day site leader training every year and must also complete
the IRS Tax Certification.

Intake Greets clients and checks that they have brought their identification

Screener documents and all other necessary tax documents. Intake Screeners also
assist with managing the flow of clients and help interested clients apply for
CFR cards.

Case Conducts an in-depth review of each client’s materials and tax situation,

Reviewer working one-on-one with each client to review their IRS Form 13614-C and
other documents to ensure the client is in-scope for VITA. This role is crucial
for smooth site operations. Case Reviewers are encouraged to also complete
the IRS Tax Certification.

Tax Works one-on-one with clients to complete their Federal and lllinois tax

Preparer returns using Intuit ProSeries tax software. Tax Preparers must also complete
the IRS Tax Certification.

Quality Works one-on-one with clients to review and finalize the completed Federal

Reviewer and lllinois tax returns. Quality Reviewers then explain the return to the client
and informs the client their refund/amount owed. Quality Reviewers must also
complete the IRS Tax Certification to prepare and review returns.

Interpreter  Assists volunteers in working with clients who speak other languages,
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including Spanish, Polish, and Chinese (contact us for more details).
Interpreters are required to complete the prerequisites.



CLIENT INTAKE

Review the Intake Sheet (IRS Form 13614-C) carefully to ensure the client’'s answers to
the questions are clear. If anything is unclear, ask your Site Manager/Leader.

Social Security Cards &
Photo ID

A client must bring original Social Security cards (or ITIN
letters) for all individuals on the tax return.

A client must bring photo ID for themselves and spouse (if
applicable).

If Married Filing Jointly, BOTH spouses must be present.

Income Guidelines

Households earning up to $56,000 annually
Individuals earning up to $30,000 annually

Income
Documents

A client needs to bring all W-2s and 1099s for jobs they
and/or their spouse worked during the tax year, as well as
documentation for Social Security payments, unemployment,
interest income, and any pensions or retirement income.

Supporting
Information

Expenses related to self-employment, also mortgage interest
statements, property tax bills, student loan interest, tuition,
college expenses, etc.

Rental
Income

Ladder Up will not prepare returns for clients with rental -
income. Rental income is Out-of-Scope for the VITA program.

Child Care Expenses

An EIN (Employer Identification Number) or SSN (Social
Security Number) for the childcare provider is necessary to
claim the Child and Dependent Care Expenses Credit.

E-Filing Tax Returns

The client and spouse (if applicable) must sign IRS Form
8879 (IRS e-file Signature Authorization) and IL-8453 (lllinois
e-file Signature Authorization) in order to electronically file
their tax return.
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SITE OPERATIONS

Each tax site has unique qualities, but general operations are the same. Here are some
of the standard activities and procedures which all volunteers should follow.

Initial Review of Tax Preparation of Quality Review
Intake/Screening Situation Tax Return of Return

Site Leaders,
Intake
Screeners, and
Case
Reviewers
arrive early to
set up site.

Site Leaders
meet with
volunteers and
clients to go
over site
procedures.

Volunteers
must wear a
nametag
showing their
first name &
initial of last
name (ex: Bob
B.)
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Intake Screener

Greets clients
arriving at the
tax site and does
a quick visual
check to ensure
that the client
has their tax
documents, 1D,
and SS Cards.

Adds clients to
the initial Tax
Assistance
Sign in Sheet
and gives the
client paperwork
to complete.

Case Reviewer

Conducts an in-
depth review of
each client's
materials and
tax situation,
determines best
filing status for
the client, and
ensures client’s
tax situation is in
scope.

Adds in-scope
clients to the
TAP Client
Tracking Sheet.

Tax Preparer

Works one-on-
one with clients
to complete the
initial Federal
and lllinois
return using
Intuit ProSeries,
a professional
tax software.

Quality Reviewer

Works one-on-one
with clients to
review and finalize
the completed
Federal and
lllinois tax return.

Quality Reviewer
then prints the
return, reviews the
return line-by-line
with the client,

and assists the
client in preparing
their materials for
e-filing or paper
filing.



WHAT'S NEW

Below are highlights of some of the notable changes for tax year 2019.

Due Date of Tax Return
The due date for tax year 2019 returns is Wednesday, April 15, 2020

Refund Delays

The IRS will hold the refunds on EITC and ACTC related returns until Feb. 15". This
delay gives the IRS additional time to help prevent revenue lost due to identity theft and
refund fraud.

Standard Deduction Increases

The standard deduction for taxpayers who do not itemize deductions on Schedule A has
increased. The standard deduction amounts for 2019 are:

$24,400 — Married Filing Jointly or Qualifying Widow(er) (increase of $400)
$18,350 — Head of Household (increase of $350)
$12,200 - Single or Married Filing Separately (increase of $200)

Earned Income Credit (EIC)

For 2019, the maximum credit is:
$6,557 with three or more qualifying children
$5,828 with two qualifying children
$3,526 with one qualifying child
$529 with no qualifying children

To be eligible for a full or partial credit, the taxpayer must have earned income and
adjusted gross income of at least $1 but less than:

Qualifying Children Claimed
If filing Zero One Two Three or more
S'”g'e’Q'JVOH’ °" | $15570 | $41,094 | $46,703 $50,162
Married Filing
Jointly $21,370 $46,884 $52,493 $55,952

The taxpayer also may not have investment income greater than $3,600 for the year.
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ITINs Set to Expire

If a taxpayer, spouse, or dependent has an Individual Taxpayer ldentification Number
(ITIN) that has not been used on a tax return for Tax Year 2016, 2017, or 2018, it will
expire 12/31/2019. Additionally, ITINs with the following middle digits will also expire at
the end of the year (12/31/2019).

83, 84, 85, 86, or 87

For example, if a client has the ITIN 9XX-86-XXXX, the ITIN will have to be renewed
before the tax return is filed. Ladder Up can assist affected clients in preparing renewal
applications. Advise clients to contact us at ITIN@goladderup.org or leave a message at
(312) 409-1555 to schedule an appointment.

ITIN's with the middle digits 70, 71, 72, 73, 74, 75, 76, 77, 78, 79, 80, or 81, expired prior
to 2019. If clients have an ITIN with these middle digits and if they have not yet renewed
the ITIN, follow the same process as in the prior paragraph to have these ITINs
renewed. After a client renews their ITIN, the number they need to use will remain the
same. The only difference is that the letter they receive will say “renewed” on it, and the
client does not need to renew a second time.

Form 1040

Form 1040 has been redesigned (again!) for 2019. The Form 1040 is supplemented with
Schedules 1, 2, and 3. These additional schedules will be used as needed to complete
more complex tax returns.

There is also a new form 1040-SR, U. S. Income Tax Return for Seniors which is
designed for taxpayers 65 and older. The form has increased font size and includes a
standard deduction chart. As in prior years, Ladder Up will use only Form 1040 for
TAP clients.

State of lllinois Updates

lllinois residents are now required to provide their county of residence.

¢ Single and Head of Household filing status are now displayed separately on the
return.

e Estimated tax payment threshold increased from $500 to $1,000.

e The tax year 2019 exemption amount for Illinois is $2,275.
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WHO SHOULD FILE A FEDERAL RETURN?
Taxpayers may not know which filing status to use. For the purpose of determining whether a
person must file a return, narrowing the choices down to the most likely filing status is

adequate in most cases. If the taxpayer doesn’'t know their filing status, use the interview tips
in the TAP Client Intake and Case Reviewer Guide.

FILING STATUS

Taxpayers must use one of five filing statuses. Filing status impacts the calculation of
income tax, affects the amount of the standard deduction, and determines allowance or
limitation of certain credits and deductions. More than one filing status can apply to a
taxpayer; use the one that will result in the highest standard deduction.

Highest Deduction

Lowest Deduction

Married Filing Jointly

Married living together with or apart from
his/her spouse, or if his/her spouse died
during the tax year.

Qualifying Widow(er) with a Qualifying
Child

Widowed because his/her spouse died during
2017 or 2018, and with a qualifying child.

Head of Household

Unmarried (or considered unmarried*) and
pays more than half the cost of maintaining a
home with at least one qualifying person.

Single
Unmarried, divorced, widowed, or legally
separated according to his/her state of law.

Married Filing Separately
Married and living with, or apart from, his/her
spouse

* Spouse did not live in home for last 6 months of the year, qualifying person must be
your child who lived in your home >% year and for whom you can claim an exemption.
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4 Chart A - For Most People Who Must File

If you may be claimed as a dependent by another taxpayer, you must file as a dependent whether you are being
claimed or not. See Chart B.

THEN file a return
if your gross
AND at the end of 2019 |income was at

If your filing status is... you were...” least...”™
Single under 65 $12,200
65 or older $13,850
Married filing jointhy™* under 65 (both spouses) $24 400
65 or older (one spouse) $25,700
65 or older (both $27.000
SpouUses)
Married filing separatel
(see the Ins?ruct?ons fo?: Form 1040) any age D
Head of household under 65 $18,350
(see the Instructions for Form 1040)
65 or older $20,000
Qualifying widow(er) (see the under 65 $24 400
Instructions for Form 1040) 65 or older $25,700

* If you were bom on January 1, 1955 you are considered fo be age 65 at the end of 2019, (If your spouse died in 2019 or if you are preparing a retum
for someone who died in 2019, see Publication 501)
** Gross income means all income you received in the form of money, goods, property, and services that isn't exempt from tax, including any income:
from sources outside the United States or from the sale of your main home (even if you can exclude part or all of it).
* Do net include any social security benefits unless
{a) you are married filing a separate return and you lived with your spouse at any time in 2019 or
(b} cne-half of your social security benefits plus your other gross income and any tax-exempt interest is more than $232,000 ($32,000 if married
filing jointly).
If {a) or (b) applies, see the Form 1040 Instructions to figure the taxable part of social securiy benefits you must include in gross income.
= Gross income includes gaing, but not losses, reporied on Form 8843 or Schedule D.
* Grozs income from a buziness means, for example, the amount on Schedule G, line 7, or Schedule F, ling 9. But, in figuring gross income, don't
reduce your income by any losses, including any loss on Schedule C, ling 7, or Schedule F, line 9.

== |f you didn't live with your spouze at the end of 2019 (or on the date your spousze died) and your gross income was at least §5, you must file a

refurn regardless of your age.

Individuals who do not have a filing requirement based on this chart should also check Chart C, Cther Situations When You Must File, and Chart
D, Who Should File. Individuals with eamed income but who do not have a filing requirement may be eligible for the Earned Income Credit.

\ ,/

Additional information and charts on Filing Status and Dependents are included in the TAP
Client Intake and Case Reviewer Guide and IRS Publication 4012.
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DETERMINATION OF FILING STATUS — INTERVIEW TIPS

Use these interview tips and additional tables in the TAP Client Intake and Case Reviewer
Guide, and the Pub4012, page B-8, to determine Qualifying Person for Head of Household

' N\

Filing Status - Interview Tips

Probe/Action: Ask the taxpayer:

step

Were you married on December 31 of the tax year?® You are considered unmarried if, on the
last day of the year, you were legally d from your sp under a divorce or separate
maintenance decree. State law governs whether you are married or legally separated under

a divorce or separate maintenance decree. Individuals who have entered into a registered
domestic partnership, civil union, or other similar relatlonshlp that is nul called a marriage under
state (or foreign) law are not o« i married. Ata is d regardk of where the
spouse lives.

If YES, goto Step 2.
If NO, go to Step 4.

step

Do you and your spouse wish to file a joint return?

If YES, your filing status
is married filing jointly.
If NO, go to Step 3.2

step

Do all the following apply?

* You file a separate return from your spouse

* You paid more than half the cost of keeping up your home for the required pericd of time.'

* Your spouse didn't live in your home during the last & months of the tax year?

* Your home was the main home of your child, stepchild, or foster child for more than half the
year. Include any individual who would qualify as your dependent except he or she does not
meet the gross income test, does not meet the joint return test, or if you could be claimed as a
dependent ith payer. (a grandchild doesn’t meet this test)

* You claim an exemption for the child {unless the noncustodial parent claims the child under
rules for divorced or separated parents or parents who live apart)

If YES, STOP. You are
considered unmarried
and your filing status is
head of household.

If NO, STOP Your filing
status is married filing
separately’.

Did your spouse die in 2017 or 20187

If YES, go to Step 5.
If NO, go to Step 6.

Do all the following apply?

* You were entitled to file a joint return with your spouse for the year your spouse died

* You didn't remarry before the end of this tax year

* You have a child or stepchild who lived with you all year, except for temporary absences or
other limited exceptions, and who is your dependent or who would qualify as your dependent
except that: he or she does not meet the gross income test, does not meet the joint retumn
test, or except that you may be claimed as a d dent by another taxpayer. Don't include a
grandchild or foster child.

+ You paid more than half the cost of keeping up the home for the required period of time.’

If YES, STOP. Your filing
status is qualifying
widowi{er) with
dependent child.

If NO, go to Step 6.

(6]

Do both of the following apply?

= You paid more than 1/2 the cost of keeping up your home for the required period of time.

* A "qualifying person,” (see Who |s a Qualifying Person Qualifying You To File as Head of
Heousehold? chart), lived with you in your home for more than 1/2 the year*

YES —Head of
Heousehold
NO - Single

Footnotes
' Include in the cost of upkeep eapenses such as rent, morigage interest, real estate taxes, insurance on the home, repairs, utilities and food eaten in

the home. Under | a taxpay

may treat @ home's fair market rental value as a cost of maintaining a household instead of the sum

of payments for mortgage interest, properlyhaxes and insurance. See "Cos! of Keeping Up a Home" worksheet later in this tab.

* You are considered unmarried for head of household purposes il your spouse was a nonresident alien al any time during the year and you donol
choose to treat your nonresident spouse as a resident alien. However, your spouse is not a qualifying person for head of household purposes. You
must have another qualifying person (see Who |s a Qualifying Person Qualifying You To File as Head of Household? chart later in this tab) and meet
the dther tests to be eligible to file as a head of household

? Your spouse is considered to live in your home even if he or she is temporarily sbsent due toiliness, education, business, vacation, military service, or
incarceration.

*You can't use head of househdld filing status based on any person whois your dependent only because he or she lived with you for the entire year (for
example, a compenion or & friend).

#If fling a MFS return in a community property state, allocale income and expense according to state law, This situation may be treated as Out of
Scope.

“1fyour spouse died during the year, you are considered married for the whole year for filing status purposes. If you didn't remarry before the end of the
year, you can file a joint retumn for yourself and your deceased spouse. If you remarried before the end of the tax year, you can fie a joint returmn with
your new spouse. In that case, your deceased spouse's filing status is married fling separately for that year.
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DEPENDENTS

Each dependent must be entered into the Federal Information Worksheet, Part .
Claiming dependents is very important for a number of tax benefits. Dependents are
classified as either a qualifying child or a qualifying relative. Spouses are not
dependents.

Dependents cannot claim any exemptions for their own dependents.

DETERMINING DEPENDENCY

There are several tests for determining dependency:

1. Dependent Taxpayer Test

In order to claim a dependent, the taxpayer and/or spouse cannot be claimed on
someone else’s return.

2. Joint Return Test

You can't claim a married person who files a joint return as a dependent unless that
joint return is only to claim a refund of income tax withheld or estimated tax paid.

3. Citizen or Resident Test

The dependent must be one of the following:

e U.S. citizen

e U.S. resident alien (for tax purposes)

e U.S. national

¢ Resident of Canada/Mexico (foreign exchange students do not meet this test)

Exception: For a taxpayer who is a U.S. citizen or U.S. national and has legally adopted a
child who is not a U.S. citizen, U.S. resident alien, or U.S. national, this test is met if the
child lived with the taxpayer as a member of his household all year. This exception also
applies if the child was lawfully placed with the taxpayer for legal adoption.

A dependent is determined to be one of the following based on Relationship, Age,
Residency, Support and other specific tests:

e A qualifying child
e A gualifying relative

Additional tables are printed in the TAP Client Intake and Case Reviewer Guide and IRS
Publication 4012.
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SUMMARY OF DEPENDENCY REQUIREMENTS
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FEDERAL INFORMATION WORKSHEET — PART |Il CODES

Earned Income Credit (EIC or EITC):
A dropdown menu appears for the type of qualifying child for the Earned Income Tax
Credit (EITC). For more information, see the dependency chart on page 14.

E: Qualifying child

H: Qualifying child but also qualifies another person for EITC

S: Student age 19 to 23 and younger than taxpayer (enrolled in college at least part-
time)

D: Disabled child age 19 or older

N: Non-qualifying person

Dependent:

Use information on the IRS Form 13614-C, Page 1 — Part Il and the determination of
dependency chart on page 14 to determine if the taxpayer can claim a person as a
dependent.

Code: A dropdown menu appears for the type of dependent
L: Dependent child who lived with client

N: Dependent child who did not live with client due to divorce or separation (remember
to apply tiebreaker rules if child lives between two households during the year)

O: Other dependent*

Q: Not a dependent (but is a qualifying person for the EITC and/or the credit for child
and dependent care expenses)**

*Other Dependent refers to a Qualifying Relative.

**This is commonly a child who could be claimed as a dependent but for failing the
support test, or who was claimed as a dependent by the non-custodial parent under the
special rules for children of divorced or separated parents.

For more information about how to enter client information into the Federal Information
Worksheet, see the ProSeries Tax Manual: Earned Income Tax Credit.
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TAX RETURN PREPARATION CHECKLIST

0 STEP 1. Ask to see the client’s photo ID and SS Cards/ITIN for everyone on the
return and check all their paperwork
» Ensure that the return you are preparing is in scope for the program and
within your certification level
» Look to see that the top of the ProSeries TAP Client Data Sheet was filled in
(including site name and date)
» Look at the IRS Form 13614-C to ensure that all “Unsure” responses in Parts
I, IV, or V are corrected to say “Yes” or “No” and that all grey boxes have
been completed.
» Check to see that the Ladder Up Client Agreement has been signed and
dated before you prepare the return.

0O STEP 2. Make sure the computer is connected to the correct Ladder Up network
(offline), and open ProSeries for the Tax Year the client wishes to prepare.

Start a new client file by going to the top left-hand corner and clicking File >
New Client.

» If the client had their return prepared by Ladder Up at a ProSeries site last
year, you will transfer their file forward. (See Mini Manual: Transferring Client
Files, page 21)

» Turn CAPS LOCK on.

0 STEP 3. Complete the Federal Information Worksheet using Form 13614-C (IRS
Intake Sheet).

» Part | — Personal Information (enter names exactly as they appear on Social
Security cards or ITIN letters)

» Part ll — Filing Status (See Mini Manual: Filing Status, page 11). Note: Find
out if the client was ever married — if they do not have legal paperwork for a
separation or divorce, they may still be considered married.

» Part lll — Dependents (See Mini Manual: Summary of Dependency
Requirements chart, page 15). Note: Find out if the client lives with anyone
else to determine if they truly pay > 50% of household expenses and that no
one else can be claimed as a dependent. Be sure to complete all grey boxes
on IRS Form 13614-C for all dependents.

» Part IV — Earned Income Tax Credit (EITC) Information — complete the
yes/no questions and check any that apply.

» Part V — SKIP (If a client file has been transferred from a different tax site,
please make sure to change the preparer code from Firm/Preparer Info box.
See Mini Manual: Site Codes, page 38)
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Part VI — Confirm e-file or paper file with the client (only current tax year and
one-year-prior returns can be e-filed. Amendments can never be e-filed.)
- Identity Protection PIN: If taxpayer or spouse has received an Identity
Protection PIN, enter their current tax year PIN here
- Date PIN Entered: If client is e-filing, you will then be prompted to
enter today’s date
Part VIl — SKIP ALL
Part VIII — Direct Deposit (if applicable, otherwise leave blank).
- Clients who do not have account information have the option of
opening a CFR card
- If a client wants to split their refund into multiple accounts or purchase
US Savings Bonds, quick zoom to Form 8888 from this section.
Part X — SKIP ALL (Ladder Up does not offer Electronic Funds Withdrawal
Options to clients)
Part X — Additional Federal Return Information. Fill in appropriate boxes
based on the client’'s IRS Form 13614-C
- Skip down and start with “Education Expenses” (check if client or
spouse has qualified education expenses)
- End after filling in response Yes/No for “Credit for Elderly or
Disabled”)
Part XI — SKIP ALL (Ladder Up only prepares state returns for full-year
lllinois residents)
Part Xl — SKIP ALL

[0 STEP 4. Save the client’s file in the designated site folder on the Z:\ drive, inside the
tax site folder and outside of the date folder, by going to the top left-hand corner
and clicking File > Save Client.

>

If you're unsure where to save the file, please ask your Site Manager or a
more experienced volunteer, or see page 24.

» Continue to save frequently as you work on the file, so that you do not lose

any work if the software or computer unexpectedly crashes.

0 STEP 5. Enter all tax documents provided by the taxpayer. Double check IRS Form
13614-C to make sure all types of income are accounted for. We cannot prepare a
return with missing documents.

Use the yellow “Where Do | Enter?” Cheat Sheet to find where to enter
each tax form into ProSeries.

Generally, all boxes on tax documents that contain numbers must be entered
into ProSeries.

ProSeries will indicate required fields in red.
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- Note: If the client has income from another state, ask the Site Manager for
further guidance.

O STEP 6. Enter any relevant deductions and credits.

ProSeries automatically calculates most credits and deductions. However, you

will have to indicate a taxpayer’s eligibility for certain credits and deductions.

» For a list of credits and deductions that are in scope and how to enter them, refer
to the ProSeries Tax Manual

» Itemized Deductions on Schedule A: Schedule A is commonly used by taxpayers
who own a home and pay real estate taxes. Taxpayers typically know if they
itemize and will have proof of all relevant expenses. ProSeries will always take
the most advantageous deduction for the taxpayer (standard deduction vs
itemized deduction).

0 STEP 7. Address all red errors that have populated on the Federal return.

- Note: Make sure to select “No Taxpayer ID” on the Identity Verification
Worksheet for taxpayer and spouse. We check this information during other
parts of the process. Please do NOT enter this information into the client’s
return.

- Refer to the Mini Manual: Form 8867, page 30, for help filling out the Paid
Preparer's Due Diligence Checklist.

0 STEP 8. Switch over from the Federal to State (lllinois) return by clicking the “ST”
button on the top toolbar. Correct any errors that appear.

» IL Property Tax Credit - You will have to enter the Property Identification Number
(PIN) of the client’s house on Schedule ICR. The PIN is found on the property tax
bill or by visiting the County Assessor’s website and entering the client’s address.

» IL Use Tax — Refer to the Supplemental Intake Form or ask the client if they
bought anything for use in lllinois on which they did not pay lllinois sales tax.
Enter the total amount of untaxed purchases.

» K-12 Education Expense Credit — Enter qualified expenses on Schedule ICR.

O STEP 9. Complete the Tax Preparer section of the ProSeries Client Data Sheet,
including the name of the file, your computer number, and your name. The ProSeries
file name will default to the first four letters of the taxpayer’s last name and the last
four digits of their Social Security number/ITIN.

0 STEP 10. Save the client’s file a final time, by going to File > Save Client one last

time. Check to see that it is saved in the designated site folder on the Z:\ drive,
inside the tax site folder and outside of the date folder. See page 24.
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0 STEP 11. Close out of the client’s file by going to the top left-hand corner and
clicking File > Close Client. The file you just completed preparing cannot be quality
reviewed if it is still open on your computer.

0 STEP 12. Give the client a BLUE index card to reserve a place in line for the quality
review process and have the client return to the waiting area. DO NOT SHARE THE
REFUND OR AMOUNT OWED WITH THE CLIENT. The Quality Reviewer must first
review all the information in the return before sharing this information.

PROSERIES GENERAL HINTS AND TIPS

To easily navigate and find any Forms, use the Forms button at the top of the client tool
the top bar and the printed YELLOW Where Do | Enter Cheat Sheet at your tax site.

ProSeries - 2019 - [Form 1099-R Worksheet (GENERAL BANK FUNDS)]
File Edit View Forms Import E-File Tools HomeBase Update Information Window Help

O E | LE] IE%|®@| [|eF Now |FED SL | B Forms |EntryM0de| i | 1 |AError

e Press “tab” to move to the next field
Pink shaded fields must be completed

o Date fields can be filled in as MO/DA/YR (last two digits of the year is sufficient if
you type in the slashes between fields)

¢ When entering an address, enter the Zip Code first and this will auto-populate the
City & State

o Enter a form EIN first. If the payer has been entered previously, it will auto-
populate
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TRANSFERRING CLIENT FILES

Note: you can only transfer forward if the client had their return by a Ladder Up
ProSeries tax site last year. For example, you can transfer a 2018 file forward to 2019
but you cannot transfer a 2016 file forward to 2018. See Mini Manual, page 38 for a list
of tax site locations that will carry forward in ProSeries.

Eﬂ ProSeries - 2016 - [Federal Infarmation Wurkshg_

Edit View Forms Import E-File Tools HomeBase Upc Step 1: Before transferring files
New Client,,, < Ctrl+N &, o f . '
C o C':”t Ct’|+0 | € Enl you must first open a new file by
Tar f... T . . . .
Ab penhen o clicking File > New Client.
FEQ Close Client collects r
asi one Convel
traf Save Client Ctrl+5 You will be presented with a
— Save As... new, blank screen.
| ange Directory... L .
- e If this is not done, you will
—h o overwrite existing client
: Go to State/City Ctrl+G . .
¥ information.
o Go to Foreign Bank Reporting Form 114
Go to QuickEntry Mode Ctrl+M
| e Chate/City ) .
. s Step 2: Select File > Transfer
Transfer..
Print... Ctrl+P . u
Print Signature Forms... ICk‘
Print Options... Ctrl+Y ick:
Split MFJ Return...
Create PDF File...
Send to DMS... rt I
Copy Product License...
Retrieve Product License...
1 Z:\ProSeries Data\...\wini0723 )(pa‘
- 2 Z\ProSeries Data\...\gonz6124
= 3 smith966 'Dt n
=] 4 Z\ProSeries Data\...\gord6639
st n
Exit Alt+Fa
_ virddle
=I EF & Banking
S Social
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 Type of Transfer

& Complete Transfer

Replace all existing data in this 1040 return with data from a
zelected return.

Important Mote: Transfering from a TurboT ax file is not supported
from within an open retum. T o transfer from a TurboT ax file, go to
HomeBase, open the File menu and select Transfer > Transfer
Clierts.

¢ Reminder Motes and Narratives only

Add to thig 1040 retum, any reminder notes and narati
in a selected 2015 PraSeries 1040 return,

0K I /Eancel | Help

Select Return to Transfer from

Organize » New folder
4 Downloads * Name :
| Recent Places
E Videos F . Harold Washangton Librany
@& OneDrive . Resources
L Ty 32 Clents
i Libraries J. TY 2003 Clients
[ Documents Ji TV 2014 Clients
J Music 2| Lk TY 205 Clients
) Pictures 1T ) T 2016 Clients
B Videos
18 Computer
£, Windows (C)
—a Image (D:)

& SharedData2 (M
S public (efile) (

| » Computer » public (\efile) (Z) » ProSeries Data » B T =

FENANT 1033 AM Fil

10/11/201F 203 PM Filk

21,2006 11:56 &AM Fil

10/25/2017 %29 AM  Fil

4 SharedData2 (T . 4 | ]

File name:

] Search ProSeries Data A
=+ A @
Type
250 PM Fils
26 PM Fil
2016 820 AM  Fil
Select a file to preview.
2
~ [2005 TAX Files(15) -
[ Open i ’ Cancel I

Step 3: When the next screen is
presented with “Complete Transfer”
selected, click “OK”.

Step 4: Search for the file name of
the client which is always in the
same format — first four letters of
the Last name + last four digits of
the Social Security Number or ITIN

e.g. SINC1531
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Step 5. If the client was served by Ladder Up, their file will appear. Click on the file and
click “Open.” \

Select Return to Transfer from \ u
- — v t
|/ » Search Results in PAgSeries Data » - | + SIMC1531) B
iy ol el S # i I
e

Organize » =~ O 'Q'
[ & Downloads

" > SINC1531
=l Recent Places . -

" Z:\ProSeries Data\TY 2015\Harold Was...  Size: 1,06 MB
B videos F

@ OneDrive Search again in:

sl Libraries M Computer Custom... || File Contents
4 Libraries
3 Documents
JT Music
[ Pictures

B videos

Select a file to preview.

1M Computer
ﬂ_‘: Windows (C)

s Image (D:)
8 SharedData2 (W
5 public (\efile) |

4 SharedData2 (T.

File name: > [2015 TAX Files(157) -

[ Open ] [ Cancel l

Step 6: The client’s Federal and State Information Worksheet that is being carried
forward from the previous year return will populate into the return in a lighter blue-green
shade. Anything new or changed text will appear in a darker blue shade.

. . Federal Information Worksheet
e Check the client’s first name, last name, _

and middle initial and their Social D
Security Number/ITIN to ensure you Taxpayer:
have transferred forward the correct Last name ........... SMITH
client file. First name .. ... .. .. TANYA
Middle initial ... .. | | Suffix.......
A Social security no. .. ***—**_-2928
e As you check through the client’s tax Occupation ... ... OFFICE ASSISTANT
documents, make sure to remove any Date of birth ... Xx [** /1961 (mm/ddlyyyy)
tax documents that carried forward Age as of 1-1-2020 . ___ 28
that are no longer relevant in the pate of death
a g _ _ Legally blind ... O
current year (fOI’ example, if the client E-mail address ... . .. TSMITHEEMATLADDRESS . COM
switched jobs, remove the W-2 that no Work phone ... Ext
H Cell phone ........ .. (312) 466-0771
longer applies) Home bhone
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Step 7. If necessary, a form can be removed by right-clicking over the form in the
“Forms in Use” Bar on the left-hand side, and selecting “Remove this Form”.

Where Do I Enter? Form W-2 Worksheet (SUPPLY STOF

= Forms In Use -
- Info VWks _—
- W-2 Wks (SURDRLY cTro Form 1040 /

- Client Billing Remowve W-2 Wis (SUPPLY STORE) Ctrl+

= Common Print this Form
- Form 1040

- Info Wks
- Form 10404 Forms Bar Help
- W-2 Wks

099-C Wis Revert to Default
- 1099-R Wks

- 1099-MISC Wks QuickZoom to another W-2

= Cnnmial Cam

Close Forms Bar

SAVING CLIENT FILES TO Z:\ DRIVE

Once you have entered the client’s information (name, address, SSN/ITIN, etc.) make
sure to save their return. ProSeries is a desktop client and the file will not save
automatically. Please remember to save the file periodically so that any work you have
done is saved in case the computer has any issues.

When you save for the first time, make sure you are saving inside the tax site folder
and outside of the date folder.

e You must save your client filed inside the Site Location Folder (ex: Loop/Harold
Washington Library).

e Do NOT Save inside of any date folder (ex: 04.15.2020)

Current and prior-year returns should all be saved to the same location (within the
Site Location Folder). The icon and file type will indicate the tax year.

When you are finished preparing or reviewing a return, make sure you save the client’s
file a final time (File > Save Client) and then close the file (File > Close Client).
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DEDUCTIONS

On line 9 of the Form 1040, taxpayers may claim either the standard deduction or they
may opt to itemize their deductions. The vast majority of Ladder Up clients will benefit
most from claiming the standard deduction.

ProSeries will automatically calculate and apply if itemizing leads to a higher refund.

STANDARD DEDUCTION

If the total of all the client’s itemized deductions is less than the standard deduction, you
will choose to use the standard deduction. The basic standard deduction is a reduction
to adjusted gross income that varies according to filing status.

In some cases, the standard deduction
can consist of two parts, the basic
standard deduction and additional
standard deduction for age or blindness or

both.

The additional amount for age will be
allowed if the taxpayer is age 65 or older
at the end of the tax year. A taxpayer who
reaches age 65 on January 1st of any
year is deemed to have reached that age
on the preceding December 31st.

The additional amount for blindness will
be allowed if the taxpayer is blind on the
last day of the tax year. A certified
statement from a doctor or registered
optometrist will be required in order for a
legally-blind taxpayer to claim the
additional deduction amount.

Dl 9T AT

Legally blind

If the client is legally blind, mark
the box under their personal
information in Part | of the
Federal Information Worksheet
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DEDUCTIONS (Cont.)

Certain individuals are not entitled to the standard deduction:

e A married individual whose filing status is Married Filing Separately whose
spouse itemizes deductions (unless one spouse qualifies to file as Head of
Household)

e An individual who was a nonresident alien or dual-status alien during any part of
the year (which is Out-of-Scope)

Standard Deduction Amounts*

Additional Deduction for Taxpayers who are 65 and Older or are Blind
For 2019, the additional standard deduction for taxpayers who are 65 and older or blind
is:
e $1,650 — Single or Head of Household
$1,300 — Married taxpayers or Qualifying Widow(er)

For taxpayers who are both blind and age 65 or over use double the above amount.

Filing Status Standard Deduction Additional Amount
Single $12,200 $1,650
Married Filing Jointly $24,400 $1,300
Married Filing Separately $12,200 $1,300
Head of Household $18,350 $1,650
Quialifying Widow(er) $24,400 $1,300

*Do not use this chart if someone else can claim an exemption for the taxpayer (or their
spouse if married filing jointly).
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ITEMIZED DEDUCTIONS

Itemized deductions are certain expenses that a taxpayer can use to lower his taxable
income. Itemized deductions are entered on Schedule A.

Deductions that can be itemized include (taxpayer must have a receipt or form of proof

for each):

e Medical and dental expenses (if in excess of 10% of the taxpayer’s adjusted

gross income)

e State and local income taxes and Real estate taxes and personal property taxes
capped at $10,000

e Charitable contributions
Home mortgage interest

Casualty in Presidentially declared disaster areas

0 ltemized Deductions that are Out-of-Scope:
[ ]

Investment interest

Form 1098-C, Contributions of Motor Vehicles, Boats and
Airplanes

Taxpayers affected by limits on charitable deductions
Taxpayers that file Form 8283 to report noncash contributions of
more than $500

If the taxpayer is donating property that was previously
depreciated

If the taxpayer is donating capital gain property
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CREDITS

Tax credits are dollar-for-dollar reductions that decrease a taxpayer’s tax liability. There
are two types of tax credits — nonrefundable and refundable. For a more complete list of
credits and step-by-step instruction on how to enter the client’s information into
ProSeries, see the ProSeries Tax Manual.

Nonrefundable Credits
Nonrefundable credits can only reduce tax liability — they cannot result in a refund.

Example: If a taxpayer’s tax liability is $400 and the taxpayer qualifies for a $500 Credit
for Other Dependents, the taxpayer will not receive a $100 refund because the Credit
for Other Dependents is nonrefundable.

Common Nonrefundable Credits

Credit for Child and Dependent Care Expenses

Retirement Savings Contribution Credit

Child Tax Credit

Credit for Other Dependents

Credit for the Elderly or the Disabled

Education Credits (Lifetime Learning Credit; American Opportunity Credit is partially
nonrefundable)

Refundable Credits

Example: If a taxpayer has a tax liability of $400 and qualifies for a $500 EITC, the
taxpayer will receive a $100 refund because the EITC is a refundable credit.

Common Refundable Credits
e Earned Income Tax Credit
e Additional Child Tax Credit
e Premium Tax Credit
e American Opportunity Credit (which is partially refundable)
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EARNED INCOME TAX CREDIT (EITC)

Earned income and adjusted gross income (AGI) must be less than:

Qualifying Children Claimed
If filing Zero One Two Three or more
Single, HOH, QW $15,570 $41,094 $46,703 $50,162
Married Filing
Jointly $21,370 $46,884 $52,493 $55,952

Maximum credit for tax year 2018:
e $6,557 with three or more qualifying children
e $5,828 with two qualifying children
e $3,526 with one qualifying child
e $529 with no qualifying children

There are restrictions on EIC claims by taxpayers for whom a previous EIC claim was
denied or reduced due to any reason other than a math or clerical error. For example, a
taxpayer who was determined to have claimed the EIC due to reckless or intentional
disregard of the EIC rules may have a ban imposed for two years. If the error was due to
fraud, then the taxpayer cannot claim the EIC for 10 tax years. Ask taxpayers if they have
ever been denied the EIC. If so, you must file Form 8862, Information to Claim Certain
Credits After Disallowance, with the tax return the first time that the taxpayer claims the
credit after being disallowed. (Note: This same form is also used if the AOTC, CTC, ACTC,
or ODC were disallowed in a previous year.)

Note:

Individual Taxpayer Identification Numbers (ITINs) and Adoption Taxpayer Identification
Numbers (ATINS) cannot be used when claiming the EITC. If a couple is filing a joint return,
both spouses and all qualifying children must have valid Social Security numbers to qualify
for the EITC.
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EARNED INCOME TAX CREDIT (Cont.)

Chart of EITC Benefits

Earned Income Tax Credit
2019

Credit Amount

$6,557 — .
L} L
' '
$5,828 —
& O
?:gv' Three children
-l
Q
<
& —— Two children
o
@
a
$3,526 — v one child
~—— Mo children
$529 —
L iy Ly iy WL W,
%9, Fay s, )‘-45’:’-\45 o o, o 0,
oo e © o 3 =23 %

Source: TPC EITC Parameters, hitps/fwwwilaxpolicycenter.org/statistics/eitc-parameters
Note: Assumes all income comes from earnings. The information in this graph depicts EITC income
and credit limitations for taxpayers filing a single or head-of-household tax return.

** The Information In this graph depicts EITC Income and credit limitations for both single and head-of-household filers.

The information in this graph depicts EITC income and credit limitations for both single and
married filers.

FORM 8867 — PAID PREPARER’S DUE DILIGENCE CHECKLIST

While Ladder Up is not a paid preparer, within ProSeries, the organization is coded as one
so that its IRS-issued Site Identification Number (SIDN) will appear on all returns. As such,
the Paid Preparer’s Due Diligence Checklist (Form 8867) will appear for all clients receiving
the EIC, CTC/ACTC/ODC, or AOTC and preparers must complete all required questions
on the form or else the return will be rejected when e-filed.
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Since Ladder Up is a VITA program, the responses to these questions don’t impact the
client’s return after it is received by the IRS. Ladder Up undergoes its own due diligence
requirements with the IRS through site visits, etc.

Instructions for the Paid Preparer’s Due Diligence Checklist (Form 8867)
1. When a client qualifies for the Earned Income Credit, Child Tax Credit, or American
Opportunity Tax Credit, or Head of Household, Form 8867 will automatically populate.

— Earned nc Wes

- Child Tax Cr

- Form 10404

- Form 1040-W

- Healthcare ... (1 Error)
- Schedule 8312

- Form 8867 ( 12 Errors )
- W2/W2G Summary

- Carryover Wks

- Tax Summary Rpt

- Tax History

Sl ok DG

v

2. Clear all relevant errors by answering the questions presented on the form.

Form B867 (Copy 1): Preparer's Due Diligence Checklist

Please check the appropriate box for the credit(s) and/or HOH filing status claimed on the return and
complete the related Parts |-V for the benefit(s) claimed (check all that apply).
EIC [J eTciacTciope [ aoTC [J HOH

1 Did you complete the return based con information for tax year
2019 provided by the taxpayer or reasonably obtained by
you? [ Yes [ No

2 |f credits are claimed on the return, did you complete the
applicable EIC and/or CTC/ACTCIODC warksheets found in the
Form 1040, 1040SR, 1040NR, 1040PR, or 1040SS instructions,
andior the AOTC worksheet found in the Form 8863 instructions,
or your own worksheet(s) that provides the same information,
and all related forms and schedules for each credit claimed? ... [ Yes [ No [ MNA

3 Did you satisfy the knowledge requirement? To meet the
knowledge requirement, you must do both of the following.
Interview the taxpayer, ask guestions, and
contemparanecusly document the taxpayer's responses to
determine that the taxpayer is eligible to claim the credit(s)
andlor HOH filing status.
Review information to determine that the taxpayer is eligible
to claim the credit(s) and/or HOH filing status and to compute
the amount(s) of any credit(s) ........ ... e Yes [ Ne

.

3. Most responses will be “yes” as this form is meant to serve as a record that the taxpayer
went through an interview process.
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Exceptions include:

4 Did any information provided by the taxpayer or a third party for
use in preparing the return, or information reasonably known to
you, appear to be incorrect, incomplete, or inconsistent? (If

'Yes,' answer questions 4a and 4b. If 'No,' go to question 5.) ... .. [] Yes [® No
a Did you make reasonable inquiries to determine the correct,
complete and consistent information? ........................... [ Yes [J No

b Did you contemporaneously document your inquiries?
(Documentation should include the questions you asked,
whom you asked, when you asked, the information that was
provided, and the impact the information had on your
preparation of the return.) ... [0 ves [ Neo

5 Did you satisfy the record retention requirement? To meet the
record retention requirement, you must keep a copy of your
documentation referenced in 4b, a copy of this Form 8867, a
copy of any applicable worksheet(s), a record of how, when,
and from whom the information used to prepare Form 8867 and
any applicable worksheet(s) was obtained, and a copy of any
document(s) provided by the taxpayer that you relied on to
determine eligibility for the credit(s) and/or HOH filing status or
to compute the amount(s) for the credit(s)? [ Yes No

4. Most responses will be “yes” as this form is meant to serve as a record that the taxpayer
went through an interview process. (Answer “yes” to Questions # 1-3, #6-9 [answer NA
to question 8 if no Schedule C], and #15)

Ladder Up is part of the IRS Volunteer Income Tax Assistance (VITA) program and is
therefore not required to retain records.

15 Do you certify that all of the answers on this Form 8867 are, to
the best of your knowledge, true, correct and complete? ... ... ... Yes L] No
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POSTSECONDARY EDUCATION BENEFITS
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EINs for COLLEGES AND UNIVERSITIES
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PREMIUM TAX CREDIT

If a client has received Advanced Premium Tax Credit (APTC) it will be reported on Form
1095-A. Information entered into the Form 1095-A worksheet will automatically flow into
Form 8962 in ProSeries.

Form 8962 reconciles the amount of Premium Tax Credit (PTC) that the client is eligible to
receive with the Advanced Premium Tax Credit (APTC) received throughout the year. If the
APTC is more than the eligible amount, the difference will appear in the payments section of
the Form 1040, Schedule 3, Line 9.

If APTC payments were greater than the PTC calculated on Form 8962, the client must
repay all or part of the excess advanced premium tax credit, and the repayment amount will
appear in Form 1040, Schedule 2, Line 2.

If a person receives APTC, they must file a tax return!

Reasons that the client may have to pay back part of their Advanced Premium Tax
Credit:

e Errors in estimating a dependent’s income

e Incorrect Form 1095-A

e Change in filing status

¢ Change in household size

Remind and encourage taxpayers to report their changes to Marketplace mid-year!
(https://www.healthcare.gov/)

SAVE YOUR REFUND
The current interest rate for US Series | Bonds purchased before May 1, 2020 is 2.22%.

Clients will need to split their refund (use Form 8888, Direct Deposit of Refund to More Than
One Account) and invest in increments of $50, up to a maximum of $5,000.

If a client uses Form 8888 to split their refund, and puts at least $50 into a savings vehicle
(i.e. savings account, retirement account, savings bonds, prepaid card (including CFR
Card)), or purchases US Treasury savings bond, they are also eligible to participate in the
national SaveYourRefund Contest to win a $100, or a $10,000 Grand Prize.

If the client does not have a bank account (or access to their account information), they can
also open a CFR/US Bank Focus Pre-Paid Card at any tax site.
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SCHEDULE C

Schedule C is used to report income from a business or profession operated as a sole
proprietor or independent contractor. Taxpayers with amounts in Box 7 of Form 1099-
MISC need to complete Schedule C in order to report cash income and calculate
possible self-employment taxes. See the ProSeries Tax Manual: Schedule C for a
more complete list of Out-of-Scope scenarios and step-by-step instructions of how to
enter this type of income into ProSeries.

The following Schedule C issues are Out-of-Scope for Ladder Up:

Businesses with inventory

Business expenses that total over $25,000 or client had a net loss from business

Client used an accounting method other than cash

Client is claiming business use of the home deduction

Client sold their business

Client is required to file Form 4562, Depreciation and Amortization

Client engaged in hobby or not-for-profit activities that generated income

All car or truck deductions must be determined using the standard mileage rate. No other
vehicle operating expenses are allowed for taxpayers using the standard mileage rate
method.

Make sure to link and enter all contractor or business income for the same type of work
onto the same Schedule C. (For example, a client that is a Driver who worked for both
Lyft and Uber should have all income related to both jobs entered on one Schedule C for
Driver.)

VITA/TCE sites (including Ladder Up) are only allowed to process returns using
Standard Mileage. If the actual expenses were used in any prior year for this vehicle or
if the taxpayer wishes to use actual expenses this year, he must be referred to a
commercial preparer. The standard mileage rate can only be chosen if it was
selected in the first year that the vehicle was used for business purposes.
Standard Mileage Rate for 2019: 58 cents per mile

To add Car and Truck expenses to a Schedule C, click on Box 9: Car and truck
expenses to open a Car-Truck Worksheet.

Other Additional Vehicle Expenses that can be added to the Car-Truck Worksheet:
e Line 26a of Car-Truck Worksheet — Business related parking fees, tolls, etc.
e Line 26d of Car-Truck Worksheet — Interest on Vehicle/Auto Loan (the business portion
of the auto loan interest can be included)
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BANK ROUTING NUMBERS*
CFR Card (Pre-Paid US Bank) Routing Number: 071004200

Bank Routing Number Location
Archer Bank 071004530 Chicago, IL
Associated Bank 071925855 lllinois

Banco Popular / Popular Community 071924458 Illinois

Bank of America 081904808 lllinois

BMO Harris Bank 071025661 Illinois
Charter One Bank 241070417 Illinois

Chase Bank 071000013 Chicago, IL
Chicago Community Bank 071004158 Chicago, IL
Citibank 271070801 lllinois
Community Savings Bank 271070681 Chicago
Consumers Credit Union 271989950 Waukegan, IL
Credit Union One 271188081 lllinois

Fifth Third Bank 071923909 Chicago, IL
First American Bank 071922777 Elk Grove Village, IL
First Midwest Bank 071901604 Itasca, IL
Great Lakes Federal Credit Union 271992219 Illinois
Guaranty Bank 071974408 Illinois

Illinois Service Federal 271070924 Chicago, IL
Lakeside Bank 071001504 Illinois
Marquette Bank 071004284 Chicago, IL
MB Financial Bank 071001737 Chicago, IL
North Community Bank 071002707 Chicago, IL
NorStates Bank 071923378 Waukegan, IL
North Community Bank 071001533 Chicago, IL
North Side Federal Credit Union 271081599 Chicago, IL
Northbrook Bank and Trust Co. 071926184 Northbrook, IL
Pacific Global Bank 071006774 Chicago, IL
Pan American Bank 071006868 Chicago, IL
Parkway Bank and Trust Co. 071908160 Harwood Heights, IL
PNC Bank 071921891 Illinois
Seaway National Bank 071001216 Chicago, IL
Self-Help FCU Chicago Division 271071279 Cicero, IL
South Side Federal Credit Union 071093295 Chicago, IL
TCF National Bank 271972572 lllinois

Urban Partnership Bank 071004226 Chicago, IL
US Bank 071904779 Northern lllinois
USAA Federal Credit Union 314074269 Illinois

West Suburban Bank 71923349 Illinois

*This list is only for bank accounts opened in Illinois
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IL COUNTY LIST

City County City County
Addison DuPage County Lisle DuPage County
Andres Will County Manhattan Will County
Arlington Heights Cook County Naperville DuPage County
Aurora Kane County New Lenox Will County
Bloomingdale DuPage County North Aurora Kane County
Blue Island Cook County North Chicago Lake County
Calumet Heights Cook County Qak Brook DuPage County
Calumet Park Cook County Oak Lawn Cook County
Chicago Cook County Orland Park Cook County
Chicago Heights Cook County Oswego Kendall County
Crest Hill Will County Plainfield Will County
Darien DuPage County Preston Heights Will County
Des Plaines Cook County Rockford Winnebago County
Downer's Grove DuPage County Romeoville Will County
Elburn Kane County Schaumburg Cook County
Elgin Kane County South Elgin Kane County
Elmhurst DuPage County Springfield Sangamon County
Evanston Cook County St. Charles Kane County
Fairmont Will County Sugar Grove Kane County
Frankfort Will County Tinley Park Cook County
Gages Lake Lake County Vernon Hills Lake County
Geneva Kane County Villa Park DuPage County
Glendale Heights DuPage County \Waukegan Lake County
Grayslake Lake County West Chicago DuPage County
Harvey Cook County West Dundee Kane County
Hinsdale DuPage County \Wheaton DuPage County
Homewood Cook County Williamsburg Green  |Kane County
Joliet Will County Willowbrook DuPage County
Kaneville Kane County Wilton Center Will County
Libertyville Lake County Yorkville Kendall County
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SITE CODES

If a client was prepared at a Ladder Up tax site using ProSeries during the previous
year, please use the transfer client feature (page 21) to carry the client information
forward into the current tax year return. The Site Code from the previous year will also
carry forward. If the client is being prepared at the same site, no changes need to be
made. If a client is prepared at a different tax site, the Site Code in the Federal

Information Worksheet, Part V, must also be updated.

ProSeries Client
Transfer Tax Site Location Site Code | Appointments
Client Available

Auburn Gresham - CPL Thurgood Marshall 40

Aurora - Waubonsee College 41 Wed
Yes Austin - CPL Austin 14

Brighton Park - Greater Chicago Food Depository 35

Bronzeville - CPL Chicago Bee 37
Yes Cicero - Unity Junior High School 24
Yes Dunning - Wright College 23

Elgin - Judson University 42 Wed
Yes Englewood - Kennedy-King College 10

Evanston - Evanston Public Library 30
Yes Hermosa - WIC Diversey 1
Yes Humboldt Prk - CPL Richard M Daley 4
Yes Little Village - WIC Kedzie 18 Sat
Yes Logan Square - WIC Armitage 20 Sat
Yes Loop - CPL Harold Washington 15
Yes Melrose Park - OLMC - Casa Esperanza 22

North Lawndale - UCAN 38

Pilsen - Benito Juarez 39
Yes Plainfield - Township Community Center
Yes Pullman - Olive-Harvey College

Southland - Bloom Township 31

Springfield - Family Services 32
Yes TAP Mobile 29

Uptown - Truman College 36

Waukegan - Catholic Charities 33 Tues/Thurs
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FREQUENTLY ASKED CLIENT QUESTIONS

Why can’t | file as head of household?

For most people who ask this question, the answer is because they have no dependents. Clients
think that because they maintain their own property, they can file HOH but that is only true for
clients with dependents that live with them and that they support financially. If they do not have
dependents, then they CANNOT be HOH.

Why can’t | file as single if | am separated from my spouse?

A client cannot file as single unless they are legally separated or legally divorced from their
spouse. Taxpayer filing status is based on their marital status on the last day of the tax year. It
doesn’t matter if they don't live together or if the client hasn’t heard from their spouse in years.

Why do | need my spouse’s SSN when | am filing separate from them?

Although your client is filling separate from their spouse, in order for us to e-file the return, we
need the spouse’s Social Security number or else the return will be rejected. If your client doesn’t
have their spouse’s SSN, you can still prepare the return but it will have to be a paper file
(meaning the client will have to mail in the return).

Why do | owe the government money?

The reason why a client might have a balance due on their return is because they did not pay
enough taxes to cover their tax liability. The most common reason why people owe is because
not enough taxes were withheld from their paycheck. You can recommend that your client speak
to Human Resources at their job to make sure their withholdings information is correct as
submitted on Form W-4. You can print Form W-4 from ProSeries and help the client complete
them. IL W-4 Forms should be in the site binder or can be printed online.

A common reason why clients owe is because they are independent contractors/self-employed.
When someone is considered self-employed, that person is responsible for paying all taxes —
they have no employer who is contributing. You can recommend to your client that they make
estimated payments to the IRS and state if they decide to continue being an independent
contractor so that they don’t have a balance due at tax time. They can contact the IRS and the
lllinois Department of Revenue to set up quarterly payments.

Why didn’t | get the EIC this year when | got it another year?

The difficult thing about the EIC is that there is a sweet spot in order for a client to receive it. Your
client cannot make too much or too little or else they may not qualify for the credit. If they
received the credit last year, you might ask if their circumstances changed (i.e. they made more
or less money, one of their children is no longer a qualifying child for the credit, etc.). Remember
that if a client has an ITIN or is filing as Married Filing Separately, they are not eligible for the EIC.

Why didn’t | get any of the education credits?

There are two main reasons why someone didn’t receive an education credit: if they are filling
MFS or if they already have an undergraduate degree. The other factor is what amount, if any,
the person paid out of pocket for qualified education expenses. If a student’s qualified expenses
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are covered by grants or scholarships and the student paid nothing out of pocket, then the
student is not eligible for an education credit.

Why didn’t my donations/medical bills make a difference on my tax return?

The only way that donations or medical bills can make a difference on a client’s return is if that
the client’s total itemized deductions exceeds the standard deduction. The vast majority of TAP
clients take the standard deduction because they do not have enough in itemized deductions.
Only certain items can go onto Schedule A, which shows all itemized deductions — common
examples are medical bills (the amounts exceeding 10% of adjusted gross income), and
charitable contributions.

Can | claim my non-citizen parents who live in Mexico?

Clients can claim their non-citizen parents living in Mexico or Canada on their tax return if they
provide more than half of the financial support for the parents, if each parent had less than $4,150
of gross income, and if each parent has an Individual Taxpayer Identification Number (ITIN).
Keep in mind that Mexico and Canada are the ONLY countries for which this situation is allowed.

Why were my social security benefits taxed?

Social security benefits can be taxed if the taxpayer also received substantial income from other
sources (i.e., pension, self-employment, wages, interest, etc.). There is a formula for determining
what, if any, portion of social security benefits is taxable that can be found in the manual in the
Social Security Benefits section.

Do I need to include my Form 1095-A information on my return?

YES! If you find out your client had health insurance through the Marketplace, then it is necessary
to include Form 1095-A information on the return or else the taxpayer will encounter processing
delays. Ask your client if they can find a copy they received in the mail or ask that they contact
the Marketplace about obtaining a replacement form.

How long will it take to get my refund?

The speed with which a client can receive their refund will usually depend on how they filed (e-file
versus paper file) and through what means they are getting their refund (i.e. direct deposit versus
a check in the mail). See the chart below for estimated processing times. However, stress to your
client that it can take a little longer than that and that they can always check their refund status
online (www.irs.gov and click on “Where’s My Refund?”) or by calling the IRS.

Submission Type Processing Time
E-file with direct deposit 2-3 weeks

Paper file with direct deposit 4-5 weeks

E-file, no direct deposit 5-6 weeks

Paper file, no direct deposit 6-8 weeks
Amendment 12-16 weeks
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LADDER UP THANKS ITS FINANCIAL SUPPORTERS!

Founder’s Circle ($250,000+)

City of Chicago

Internal Revenue Service

Illinois Department of Human Services
The Prudential Foundation

Chairman’s Circle ($50,000 — $249,999)

Citi Community Development

Polk Bros. Foundation

United Way of Metropolitan Chicago
Chicago Community Trust

JPMorgan Chase

Steans Family Foundation

Paul M. Angell Family Foundation

Director’s Circle (520,000 — $49,999)
Bank of America

Cook County

United Way of Elgin

Discover Financial Services
Anonymous

Thomas & Maryellen Scott

Kirkland & Ellis LLP

The Lawyers Trust Fund of Illinois

Platinum Circle ($10,000 — $19,999)
CIBC

Linda McGuire
Associated Bank
Capital One

Chicago Bar Foundation
Grant Thornton LLP
KPMG LLP

Northern Trust

US Bank

Baker McKenzie

Deloitte LLP

PwC

Skadden, Arps, Slate, Meagher & Flom
United Airlines

Gold Circle ($5,000 — $9,999)
Alverin M. Cornell Foundation
Ernst & Young

Walgreens

Beth Mueller

Crowe LLP

Anonymous

A.G. Cox Charity Trust
Adtalem Education Group
Alliant Credit Union

Exelon

The Hoffer Foundation

Jones Day

Latham & Watkins, LLP
Mayer Brown

McDermott Will & Emery LLP
Reed Smith LLP

William & Barbara Welke Charitable Fund
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